
Computer Applications: Dreamweaver/Web Publishing 
 

Interface and Initial Construction 
 
Download Day One Folder from Computer Applications folder on 
Drama_dc02/Computer Applications 
Open Program and click on standard interface. 
 
Interface: 

 The document is in the center of the window 
 Site Control/Management is on the right 

• This area is extremely important since your links are all 
maintained through the file structure that you create here 

 Tabs at top of window are for the most used operations.   
• Most of those features can be found elsewhere in pull down 

menus, etc… 
• You will usually want to keep the common tab on top 

 Pull down menus on the top are very similar to other windows 
programs 

 Title is something that you will type in that will be for your own 
reference.   

• This is not the file name. 
 Properties Pallet on the bottom controls many aspects of different 

elements of your web page. 
• If you highlight an aspect of your web page, such as a table or an 

image, you will see its unique properties in the Properties Pallet. 
 
Begin Construction: 

 File pull-down/New 
• Choose: Basic Page and HTML 
• Click Create 
• In title text field, name your page “home” 
• File/save 

 You have now created a page, but you must also create a site, which 
will contain and manage all of the pages you create. 

 To define a site, go to the files panel on the right and click on the 
arrow. 

• Click on site tab 
• Click on site arrow below tab 
• Click on new site 
• In the site definition pop-up that appears, name your site with 

your name.  Don’t use spaces. (make sure that you are on the 
basic tab) 

• Click next 
• Click on “no server technology” button 



• Click next 
• Edit local copies on my machine 
• Save your files on Computer Applications on the Drama Server 

in your folder 
• Next 
• How do you connect to your remote server: none 
• Next/done 

 Note that your site folder now appears in the folder hierarchy under 
the site tab.   

 File/save as/index.htm  You will want to save this in your site folder 
 You have now created a site and a page within that site. 
 Drag all of the files within the Day One Folder (not the whole folder) 

into your web site file 
 
Begin adding attributes to your web page 

 Page Properties: right click in the center of your document 
 Choose page properties at the bottom of menu 

• Note that the title that you typed in the title text field is already 
there 

• Background image: browse to the bubbles jpg and click, 
“apply” and you see that pictures of bubbles appear.  This image 
repeats or “tiles” automatically.  We aren’t going to use this file, 
for our web site, so go ahead and delete it. 

• Background Color: type in #0000CC.  This gives you an exact 
color.  Save this number because you will use it later in the web 
site building process.  You can also click on the little box and 
choose a color, in a similar manner to Photoshop. 

• Define Text colors: 
o Text: #66FFFF 
o Links: #66FFFF 
o Visited Links: #CCFF00 

• Create Margins: These margins give your web page a little 
breathing room from the top and side of the page. 

o Left Margin: 25 
o Top Margin: 10 

• A Tracing Image is an image you can underlay to help 
structure your document.  This image will NOT appear when the 
web page is loaded in a browser. 

o Browse for “bubbleswithwords” file (remember to save 
your documents without spaces or caps in the names) 

o Try out the transparency slider 
• Click Apply and you will see the results of what you’ve set up. 
• Click OK to make the changes stick 
• Look at the results in Explorer and note that the image does 

not appear on line (click on the globe icon under the common 
tab) 



• Go back to Dreamweaver and delete that image 
 Click in your document and start typing.   

• Note that your type is in the color you have set up in page 
properties. 

• Note also the Properties menu below.  You have a few options 
there for the text you have just typed. 

 
Tables 

 All web sites are built on a rigid framework, even if they look free-form.  
This framework is usually some form of table or of other elements 
converted to a table. 

 Create a table 
• Under the Common tab, click on Insert Table button (if you 

can’t remember where a button is, roll you mouse across the 
buttons and names will pop up) 

• In the pop up, type in 8 rows, 2 columns, 100%, ) border and 
click OK 

• You will now see a table appear in white dotted lines on your 
document. Look at your doc in a browser and you will see that 
you can’t see those borders 

• When you begin working with a web page, starting with a table 
is a great way to make your document more flexible.   

• Click in one of the cells of the table.  Look at the bottom left 
hand side of your document. What you see there are HTML 
symbols for the various aspects of your document.  They are in 
order of biggest element to smallest element.  Think about your 
web site as a bunch of boxes, all of which are nested inside of the 
big box that is your site.  In this case <td> stands for “cell”, 
<tr> stands for “row” <table> is…. and <body> is the 
container for the page.  Click on any of these symbols and you 
will see a different part of the document highlighted.  This is a 
good way to highlight different aspects of your document, 
particularly if you have a very complex page. 

• Highlight the table and note the properties menu. 
o W and H are width and height.  100% means that the 

table will adjust to the size of the browser window in 
which it is opened.  You can also set the table width or 
height in pixels if you choose. 

o You can align the table in the browser window.  Note the 
movement of the table as you change the alignment. 

o The reason that your table is not aligned with the top left 
of your window as a default is that we set the margins in 
Page Properties 

o You can change the background color and image of 
the table in a similar to the way that we did in page 
properties.   



o You can also name the table in the Table Id area.  Name 
the table “main table”.  Note that in the bottom left of the 
document window that  the name is listed as well as the 
table designation. 

o Set the following: 
 Border: 2 (Border is the width of the grid lines 

that create the table 
 Cell Space: 3 (Cell space is the space between 

the cells) 
 Cell Pad: 0 (Cell pad is the space around the 

elements in the cells) 
 Align: Center 
 Background Color: #0000CC 
 Border Color: #FFCC00 

 Click and drag across two top cells so that both are highlighted. 
 Click on the Join Cells button in the Properties/Cell palette 
 Note that the border disappears. 
 You can also split cells using the Split Cells button next to the join 

cells button. 
 Join the six cells in the right column 
 Save the document as “index” (which will help this default to being 

your homepage)   
 You have now created the structure for our homepage! 
 Click on the little globe icon (keyboard shortcut F12) to see your table 

in a browser.  Note that the size of the table adjusts to the window size. 
 Invisible borders:   

• Highlight your table and in the Properties Palette: 
• Cell Space: 0 
• Border: 0 
• Border Color: None 
• Enter 
• Preview in Explorer and your have invisible borders. 
• Don’t save these last changes. 
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Designing a Header, Text, Flashtext 
 
Download Day Two Folder and your saved Dreamweaver file from last 
class from Computer Applications folder on Drama dc_02 
Open Program and click on standard interface 
 
Designing a Header 

 Much of your web design work will be done in other programs and then 
imported into Dreamweaver.  We will be doing all of our image work in 



Photoshop using skills gained at the beginning of the semester.  You 
will discover that many of the features of Photoshop are created for 
Web Design. 

 Create a Header 
• Open Photoshop 
• Open the color swatcher and put in the same background color 

that you were using in your Dreamweaver table (#0000CC). 
• Create a new document that is 950x200 pixels 
• Type “Mundell Shoe Store Design” (or use your own name) 
• Change the font and adjust the size to fill the document with a 

little border 
• Crop to the lettering to keep the image as small as possible 
• Add layer effects 
• File/Save for Web.  This will create a GIF that will allow you 

to have some colors that are transparent.  This will allow for the 
image to load more quickly. 

• Click on the background color in the palette to the right 
• Click on the map to transparent box at the bottom of that 

palette 
• Click on save and save as “logo” into your web site. 
• Note that the GIF appears in your file hierarchy in the Site 

Palette 
• If you do see it there, hit the Refresh Button (the circular 

arrow under the site tab) and look again at the hierarchy. 
• Click and drag the file into the top cell of your table 
• Note that the properties menu now reflects the image 

characteristics including the exact size of your image 
• Note also that the table cell has automatically resized to 

accommodate the image 
• Examine in the browser window. 
• Note that the table has sized to fit the browser window on your 

monitor which may not be terribly attractive! 
• To constrain the table width to the size of your image, record the 

size of the image (from Properties Palette) 
• Highlight the table  
• Change the width to the same amount of pixels as the image. 
• Preview again and note that the image fits more gracefully in the 

cell. 
•  

How Big should my Website be on the screen? 
 

 Most designers design for smaller screens.  640x480 is a small 
standard size.  We are obviously throwing caution to the wind and 
designing for a bigger screen.  People with 14” laptops will probably 
have to scroll!  Our website home page will fit comfortably on a 17” 



monitor with room for a favorites menu open in the browser. 
 Note that you can automatically change your document (at the 

beginning of the process) to standard screen proportions with the 
window size pull-down at the bottom center of your window.  The 
next number over is how big the webpage is and how long it will take to 
download (a pretty useless number since there are so many factors). 
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Text, Flashtext, Links 
 
Download Day Three Folder and your saved Dreamweaver file from last 
class from Computer Applications folder on Drama dc_02 
Open Program and click on standard interface 
 
Text 

• Click in an open cell and begin typing. Type more than one line. 
• Highlight text and look at properties menu. 

o You’ll see that you have very few choices. 
• Use the text pull down menu. 

o Note that font list is groups of fonts.   The browser will default to 
one of these fonts on the user computer.  There aren’t many to 
make sure that all computers will be able to read your font. 

• Note that when you hit enter, Dreamweaver defaults to a new paragraph.  
When you create a paragraph, that you want to look a certain way, you 
must contain the size of the table cell in order to make the paragraph work 
the way that you want. 

• You can create headers instantly with the text tab. 
o You can also create bullet lists that way. 

• This kind of text loads the most quickly. 
 
Flashtext 

• However, on our website, we are going to want to create some better 
looking text 

o Go to second right cell of your document. 
o Click on the media tab. 
o Click on the Flashtext button. 
o Type “resume”. 
o Add rollover color, background color, font, and native color. 
o Click “apply” and check on the font size. 
o Adjust the font size. 
o Preview in explorer. 



o Roll your cursor over the lettering and notice how it changes. 
• Flashtext is actually images 

 
Rollovers 

• Building rollovers in Photoshop 
o Build two images and save them into your website folder. 
o Click in cell 
o Click on rollover image button in common tab 
o Add the two images. 
o Click ok 
o Look at in Explorer 

 
Importing HTML 

• Open the Dreamweaver file in day three: resumedoc.htm.  This is what we 
are aiming for. 

o Open Word Document in Day Three: Mundell Shoe Store Design 
o Save as HTML into your web file on your desktop 
o Note that it has been created in a table. 
o Create a new page (file/new). 
o Call it resume and save it as resumedoc on your desktop 
o File/import/HTML 
o Let Dreamweaver clean up the file. 

• Right Click on page background 
o Go to page properties 
o Small shoes as background image 
o Click on table 
o Properties 

• Align Center 
• Change font of entire document 

 
Links 

• You can add links to almost any part of your web page. 
• Relative links are those that go outside of your website 
• Absolute links are those that stay within your website. 

 
Relative link 

• Highlight “Art Institute of Pittsburgh” 
• In properties, type:  http://www.aip.aii.edu/ in link 
• Hit enter 
• Note that that word is now underlined.  This means that it’s a link 
• Look at the page in explorer. 
• Click on Art Institute of Pittsburgh 
• It automatically links to that page 

 
Absolute link 



• Click outside of your table 
• Hit enter so that your cursor is below your table 
• Type Home in CAPS 
• Make the text bold and align center 
• Highlight the word home 
• In the Link text field in the properties menu, browse to your homepage 
• Examine in Explorer 
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Links, Photo Albums, Cascading Style Sheets 
 
Download Day Four and Five Folders and your saved Dreamweaver file 
from last class from Computer Applications folder on Drama dc_02 
Open Program and click on standard interface 
 
Links 

• You can add links to almost any part of your web page. 
• Relative links are those that go outside of your website 
• Absolute links are those that stay within your website. 

 
Relative link 

• Highlight “Art Institute of Pittsburgh” 
• In properties, type:  http://www.aip.aii.edu/ in link 
• Hit enter 
• Note that that word is now underlined.  This means that it’s a link 
• Look at the page in explorer. 
• Click on Art Institute of Pittsburgh 
• It automatically links to that page 

 
Absolute link 

• Click outside of your table 
• Hit enter so that your cursor is below your table 
• Type Home in CAPS 
• Make the text bold and align center 
• Highlight the word home 
• In the Link text field in the properties menu, browse to your homepage 
• Examine in Explorer 

 
Hot Spots 

• For creating links in images 
• New page 



• Load Baby Shoes 
• Click in image 
• Draw Hot spot around foreground shoe (hot spot buttons in lower left) 
• Add a link 

 
Photo Albums (Easy Portfolios) 

• In Dreamweaver 
o Commands 
o Create Web Photo Album 
o Fill in Headings 
o Find Source Folder (Portfolio) 
o Create Destination Folder (Day Five) 
o Make Thumbnails 144x144 
o Don’t show file names 
o Click ok and let the computer work. 
o Album Created-click OK 
o You’ll see the portfolio page. 
o Look at it in Explorer and Click on the links 

• Create a fully formatted Photoshop Portfolio 
o Open Photoshop 
o File/automate 
o Choose a style you like 
o Browse to your portfolio Folder 
o Destination: Day four 
o Give your portfolio a name 
o Change the font 
o Click Ok and let the computer work 
o Explorer should open 
o Slide will change every 10 seconds or you can click on links 

• Cascading Style Sheets (CSS) 
o Allow you to format multiple pages easily 
o Back to Dreamweaver 
o Design Pull Down 
o Click on the “new CSS” button at bottom 
o Name: Portfolio 
o Make Custom Style 
o New Style Sheet File 
o Click OK and save in day four/ portfolio/ as portfolio 
o Change Settings on Background and type 
o Select “Body” on your portfolio HomePage 
o Drag “portfolio from CSS Styles over document 
o You can then do the same thing with all of your portfolio documents 
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Frames, Layers and Meta Tags 



 
Frames 

• Frame Tab:  Choose one on left 
o Lots of Saving and naming to make frames work: 
o Make folder: Frames 
o Save Left frame 
o Save Right Frame 
o Save Frameset 

• Show Properties: Same as page properties 
o Put Content in both 
o Make link on left 
o Refers to itself and usually we use that for index 

• Name frames 
o Window>Others>Frames 
o Properties will allow you to name frames 
o Show other properties in that panel 
o Including scroll 

• Go back and make a link 
o Use target pulldown in properties menu. 
o Show Frameset properties by clicking on frame (double click for 

properties) 
• Note that left column is designated in pixels and right is in percentages 

 
Layers 

Note: This tutorial is based on Macromedia Dreamweaver MX tutorial. 

Layers are very important, at least you should know how to use them, because 

they are very flexible in designing something of your own. When you want to 

create your own navigation system, or to make a mouse over actions, or even 

tooltip you can do all these with layers very easily. In this tutorial I will show 

you how to use layers, and we will do a little navigation system. Then once you 

know how to use them, you can implement them according to your own 

creativity. 

Create an image like the one below: we will work with it to create a menu. 

 

OK Let's start creating our menu, open a new page in your Dreamweaver and 

save it as menu.html 



Place the above image or one similar to it in your page. Select the Draw 

Layer from the toolbar and draw a layer as shown below. 

 

Now click inside the layer and Create a Table, to do that go to Insert > 

Table (Ctrl + Alt + T) with the following specifications. 

 

After creating the table give it a background color of #999999 

Now click inside the table you have just created and create one more table, 

Insert > Table (Ctrl + Alt + T) with the following specifications now. 

 



Now select the rows (not the whole table) only and give them a background 

color lighter that is for example #F9F9F9 

By now your page should look like this 

 

Fill the table rows with Menu items, in my case I will use menu 1, menu 2...etc 

 

Next click inside the table and select the layer handle at the left top to select 

the whole layer. 



 

Now inside the properties panel Choose the layer visibility: Hidden - This 

means when the page first time opens the layer won't be visible, unless the 

user mouse overs, which we will do next. 

 

Next step is to create Mouse Over and Mouse Out actions, when the user 

mouse overs the image it will show the layer and when mouse outs it will hide 

the layer. That is quite easy to do. 

Select the "Mouse Over Me" image of yours and open Behaviors Panel 

Window > Behaviors Shift + F3. Then click on the "+" sign and select 

Show-Hide Layers. You will see a new window, click on the Show button, 

and click OK

 



In the Behaviors Panel change onLoad to onMouseOver Action. 

 

You need to repeat Step 6 one more time, but this time in the Show-Hide 

Layers click on the Hide button. Because this time we want to hide the layer 

when users mouse goes away from the image. Click OK. 

And in the Behaviors panel, change the onLoad to onMouseOut. Your 

behaviors panel should look like this now. Save the page and preview it. It 

should be showing the layer when you mouse over and hide it when you mouse 

out it. 

 



Now you know how to use layers you can start building your navigational 

system which is more complicated then this one, it will all be the same when 

you build a bigger menu system. One thing you need to remember is, when 

you show one layer you should hide the rest, unless you want it otherwise.  

 
Slices 
 
What are Slices? 

 You use slices to divide a source image into functional areas. When you save 
the image as a Web page, each slice is saved as an independent file that 
contains its own settings, color palette, links, rollover effects, and animation 
effects. You can use slices to achieve faster download speeds. Slices are also 
advantageous when working with images that contain different types of data. 
For example, if one area of an image needs to be optimized in GIF format to 
support an animation, but the rest of the image is better optimized in JPEG 
format, you can isolate the animation using a slice. 

 
Types of Slices 

 Slices you create using the slice tool are called user slices; slices you create 
from a layer are called layer-based slices. When you create a new user slice or 
layer-based slice, additional auto slices are generated to account for the 
remaining areas of the image. In other words, auto slices fill the space in the 
image that is not defined by user slices or layer-based slices. Auto slices are 
regenerated every time you add or edit user slices or layer-based slices.  

 
How Slices look 

 User slices, layer-based slices, and auto slices look different--user slices and 
layer-based slices are defined by a solid line, while auto slices are defined by a 
dotted line. In addition, each type of slice displays a distinct icon. You can 
choose to show or hide auto slices, which makes your work with user- and 
layer-based slices easier to view. 

 
Subslices 

 A subslice is a type of auto slice that is generated when you create overlapping 
slices. Subslices indicate how the image will be divided when you save the 
optimized file. Although subslices are numbered and display a slice symbol, 
you cannot select or edit them separately from the underlying slice. Subslices 
are regenerated every time you arrange the stacking order of slices. 

 
META Tags 
Meta tags will help search engines locate your site and navigate within it. 

• META tags allow search engine “spiders” find you site more easily 
o Click on Head Tab in Insert Panel 
o Click on the key and type anything someone with a search engine 



might use to find your site 
• Click on the description button 

o Type a description of your page 
o Show Code view to see the text inserted 

 
Help Tags 
Small labels that work as little rollovers for images 

• Insert image 
• Go to properties panel 
• Type name in “Alt” 
• Save all 
• Check out F12 
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Creating a File for your Website on the CMU Andrew Server 
Creating a WWW Directory 

All Carnegie Mellon affiliates are provided space on the Andrew File Server 
(AFS). Your personal web pages are stored in this directory and must be within a 
directory named "WWW". When you "publish" your pages, the server copies 
these files from your WWW directory to the server. 

• If you have a new Andrew account, your WWW directory has been created 
for you. You may skip this section and go directly to the information about 
Setting Access Rights for Publishing.  

• Follow this procedure to create a WWW directory with the proper 
protection settings. If you are not sure whether or not you already have a 
WWW directory, follow these steps.  

1. Login to your Andrew account. 
 
If you are using a Macintosh or a PC, you will need to use a Telnet 
program. Use the following information when using Telnet to login to your 
account:  
 
Host: unix.andrew.cmu.edu 
Userid: Your Andrew UserID 
Password: Your Andrew Password  

2. At the command prompt, type the following command to change your 
working directory to your account directory: 
cd ~  

3. At the prompt, type the following unix command to create the WWW 
directory: 
mkdir www  



This creates a www directory if you don't already have one. This is where 
your web pages will be stored before being published. 
If a message displays Failed to make directory "www"; File already 
exists, your WWW directory has already been created.  

Setting Access Rights for Publishing 

In order to publish your pages, the server must have authorization to the files in 
your www directory. You will use one of two commands to set access. Which 
command you use is dependent on whether you want to use KWPublish or not. 
You will want to use KWPublish if you: 

• want to restrict read access to your www directory  
• want to prohibit others from publishing your pages while you're 

working on them  
• are publishing pages for a course and you want to restrict those 

pages using .htaccess  

For more information read Using KWPublish.  

Setting Access Rights USING KWPublish 

Use KWPublish to set the protections on your www directory so that the server 
can read and publish the files. Setting access rights this way prohibits users from 
reading the files directly from AFS. 

1. While at the top level of your project volume, type the following UNIX 
command: 
 
fs sa www service.webman rl  

This command gives the server read access to your www directory, but does not 
allow other Andrew users to read the files. 

Setting Access Rights NOT USING KWPublish 

By setting access as described below you can publish your pages whether or not 
you're using KWPublish. This gives the server read access to your www directory. 
It also gives anyone else with an Andrew User ID access to the directory.  

1. While still at the top level of your project volume, type the following UNIX 
command:  

fs sa www system:anyuser rl 

Removing Access Rights 



If you had previously set access to your www directory to give system:anyuser 
read access (which you did if you published your pages before KWeb was 
introduced), you will need to remove this access if you don't want users to be able 
to read the files from your www directory. To remove the access rights you had 
set up previously, type the following command at the root of your AFS directory: 

fs sa www system:anyuser l 
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Uploading your Website and Getting it on Line 
Defining your Site on a Remote Server 

• Define a Site:  
o Edit Site 
o Choose your Website 
o Make sure that “local” view is showing 
o Make sure that your home page is saved as “index.htm” or 

“index.html”. 
o You should see your site the way that we have been working with it 

in class. 
o Click on Remote view Pull-down 
o Click on “define a remote site” 
o Access: FTP 
o Host: unix.andrew.cmu.edu 
o Directory: www 
o User name: andrew user 
o Password: andrew password 
o Click test 
o Click OK 

 
Getting your Site onto the Server 

• Click on the little plug in Dreamweaver so that it plugs in. 
• Go back to the local view. 
• Highlight the file that you would like to upload (it would probably be your 

whole site file) 
• Click the up arrow. 
• Your files are on the web server 

 
Publishing your Site 

• Go to www.cmu.edu/myandrew 
• Web publishing: andrew.cmu.edu 
• Type your user id 
• Click on publish 
• Test out your website! 



 
 


